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Introduction
Training Overview
Intended Audience
This guide is intended for those users who will create reports and charts in
BLUEcloud Analytics.

Prerequisite
There is no pre-requisite knowledge necessary before using this guide. However,
being familiar with your library’s policies will be beneficial.

Goals
After completing this guide and/or the corresponding course, staff will know
how to:


Create Dashboards



Create Reports



Modify visualizations



Schedule reports and documents for delivery via email



Set user permissions



Set user preferences and request new users be created



Organize complex displays of dashboards and dashboard layouts

Getting Connected
Access information to your particular instance of BLUEcloud Analytics will not
be provided during training. Your Site Administrator should receive the
following information from your SirsiDynix Project Manager:
URL for your instance of BLUEcloud Analytics.
Delivered usernames and passwords.
Site Administrators should change the administrator password as soon as it is
received. User logins beyond the Administrator account can be created by
contacting Client Care.

BLUEcloud Analytics Administration

BLUEcloud Analytics
Overview
Introduction
BLUEcloud Analytics is the latest generation of reporting tools for the SirsiDynix
Symphony and Horizon ILS systems. Used to its full potential, not only is it “a
reporting tool”, but also incorporates the concept of “analytics”.

Analytics Defined
Most library personnel are already familiar with the general concept of a
“report”: a grid or graph of data that mainly describes things that have
already happened.
While analytics will also show you plenty of grids and graphs, the
difference lies in the objective. Analytics is more about trends, and
anticipating future needs. In other words, analytics is more concerned
with presenting data indicating what will likely happen.

Analytics Data: Cubes
Traditional reports are extracted from database tables and views out of a
relational database, using either SQL statements or API calls. Analytics
depends on a different type of data structure known as a cube, and
accompanying technologies to support it.
If you think of tables as “flat” grids of data, think of cubes as a 3dimensional (or more) stack of them, where analyzing the data over time
is now possible:
BLUEcloud Analytics includes several different cubes, each containing
data harvested from various tables and logs in your ILS. Examples of
cubes include Checkouts, Users, and MARC. Each analytical report you
create can use data from one or more of these cubes at once.
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Terminology
The two general concepts we must understand in BC Analytics are datasets and
analysis. These are defined below, with additional terms:

Datasets
A dataset, as the name suggests, is the data that you will be extracting
information from in BC Analytics. If you are new to analytics but fairly
experienced in other reporting tools, you will be dealing with a new kind
of dataset in BC Analytics.
Cubes
A cube is the most common dataset used in analytics. If you think of
database tables as two-dimensional slabs of data that contain a ‘snapshot’
of data (like the Users table in Symphony, or the Borrower table in
Horizon), think of cubes as a stacked matrix of these snapshots. In other
words, think of cubes as a 3-d object that allows for analysis over
something, such as time.
Examples of cubes in BC Analytics include checkouts, users, and MARC.
The cubes are harvested from your library database via an automated
extraction process.
Metrics
Much of your analysis will focus on gathering statistics. Metrics are
objects in the cube that you will use to present numbers in your analysis.
Examples of metrics might include “number of checkouts” or “number of
renewals”.
Your system will come delivered with a set of metrics in each cube. You
also have some ability to create your own metrics.
Attributes
Numbers all by themselves don’t mean much. Numbers placed next to
categories will more likely mean something. Attributes are objects in the
cube that can give numbers context. Examples of attributes might include
“library” or “checkout year”.
Your system will come delivered with a set of attributes in each cube.
Only SirsiDynix can create/edit/delete attributes.

BLUEcloud Analytics Administration

Analysis
An Analysis is just that – an analysis that you develop to better
understand the workings of your library. You’ll develop an analysis
against the dataset(s) mentioned in the previous section. Some terms that
are important to an analysis follow:
Visualization
Earlier in this section, we discussed “cubes”, which are multidimensional matrices of data. BC Analytics cubes are rather large sets of
data that no human being could digest. Therefore, we need something
that can present only the data from that cube we really want.
Visualizations are what you use in a dashboard to provide a specific view
of the data. You can think of them as a close equivalent of a “report” that
comes in the form of grids and/or graphs. Your dashboards can have
one-to-many visualizations, depending on how much data you’d like to
present.
A simple dashboard may have just one visualization. More complex ones
can have multiple visualizations, such as the example below with two: a
graph and grid side-by-side.

In the Dashboard Formatting chapter later in this guide, we’ll see that
dashboards have even more sophisticated design potential, such as the
ability to divide a dashboard into tabbed/sub-tabbed pages of content.
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Reports, Documents, and Dashboards
As mentioned earlier, the “engine” and interface of BLUEcloud Analytics
is the MicroStrategy BI suite. Because of this, some terminology of
MicroStrategy’s and the reporting world in general will be clarified here.
This section will discuss the terms reports, documents, and dashboards.
Reports
In MicroStrategy, the term “report” actually refers to a specific type of
object that is exactly that: a simple grid/graph that focuses on one set of
data, and is not intended to be interactive in nature.
An example of something that might typically be shown as a report
would be a count of your patrons by various categories, like a Horizon
bType or a Symphony user category. Reports are well suited to simple,
“snapshot” data like this.
However, MicroStrategy also has two other types of output that are
sometimes loosely termed as “reports”, but are technically different
objects with slightly different intents. Let’s clarify what documents and
dashboards are.
Documents
A document is essentially a container for one or more reports.
Documents allow you to have multiple reports working together in a
specific layout of your design.
An example of a document in the library world would be notices. A few
libraries have actually replaced their ILS’ notice functionality with
Microstrategy and similar tools. To do a notice properly using
MicroStrategy, you’ll likely need data from different tables. You’ll also
have very specific formatting needs (the address goes here…the data
here…a footer here…next page). Documents are well suited for tasks like
this.
Dashboards
A dashboard is a special type of document deployed in a Flash format.
They will be the chief mechanism of presentation in this class.
Dashboards are a collection of important data that would benefit a
decision maker “at-a-glance”. For example, your cataloging supervisor
might like a dashboard of several graphs that show general trends (items
added by category, weeding activity, dusty books), which can then be
examined in more depth later.
BLUEcloud Analytics Administration

Dashboards also can be highly interactive. Where reports and documents
are generally read-only in nature, a dashboard can have graphical
elements on it that let you view the data in different ways. You can
dynamically apply filters, add a new metric, zoom in on a category of
interest, copy data to another window, and zoom out again. All without
ever leaving the current window, or flipping in and out of an “edit”
mode.
Why the emphasis on dashboards? Dashboards are especially well suited
to the mindset behind analytics, and can serve different types of
audiences from decision makers to staff.
For decision-makers: with a properly designed set of dashboards, you can
have critical data about various library operations in front of you on one
screen. Further, you can analyze, filter, and change the output in many
ways without leaving the dashboard. The example below shows how
these types of dashboards could look:

On the other hand, not everyone requires reporting like this. What if
your circulation supervisor just wants of simple grid of checkout data?
Dashboards can also present themselves much like a basic report:

Your BLUEcloud Analytics system is capable of generating reports,
documents, and dashboards. This class will focus on dashboards for the
aforementioned reasons, but you are welcome to explore using all objects
types.
10 |
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Basic Dashboards
Dashboards
A dashboard allows you to organize datasets and display them in a manner that
facilitates analysis. You may add several visualizations with multiple filters to portray
all of the desired information on one page.
This chapter will focus on simple dashboards (containing one ‘report’), and various
ways of manipulating the data’s content and appearance, including:
1. Adding/removing attributes and metrics.
2. Sorting
3. Changing between grid and graph visualizations
The examples below will demonstrate how to create a simple dashboard against the
Checkouts cube. It will start out as an analysis containing the library name attribute.
We’ll then learn how to add a metric, such as the number of checkouts. Finally, we’ll
put it through a number of changes to demonstrate various features.

Creating a Simple Dashboard: the Visualization and Dataset
To Set Up the Visualization and Dataset
1. Click the New Dashboard button:

2. Next, browse to your Checkouts cube under Shared Reports ->
Cubes -> Checkout Cube, and click Next:

BLUEcloud Analytics Administration

3. Next, you will choose a “visualization” which determines if your
output is a grid or graph. Click the Select a Visualization button:

4. In this example, we’ll start with a Grid visualization. Select the
Grid icon from the list:
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5. The Checkout Cube may include some default data that you will
want to clear from the visualization. Click the visualzations’s
options drop down and select Clear Visualzation:

Adding Attributes
Attributes are objects in a report that give context or meaning. Nonnumeric entities such as user names, titles, authors, or any Symphony
policy or Horizon code are examples of attributes. In our visualization,
we’ll add a couple of attributes that are available in the Checkouts cube:
Checkout Library and Checkout Year
1. In the Dataset Objects pane on the left, double-click the
Checkout Library attribute:

You should now have a listing of your libraries:

BLUEcloud Analytics Administration

2. Double-click the Checkout Year Attribute:

Your visualization should now look similar to the following:
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Adding a Delivered Metric
Our analysis currently has no numbers – just two attributes. While not
every visualization will have numbers, this particular one won’t mean
much without any. In these steps we’ll add a metric, which is an object
that allows you to not only insert numbers, but perform mathematical
and statistical operations on them.
The various cubes that are delivered with BLUEcloud Analytics will have
some metrics delivered with them. In some cases, you may have to create
a metric yourself. The two upcoming examples explain both processes.
To Add A Delivered Metric to the Visualization
To add a delivered metric (in this case, the Number of Renewals metric)
to a visualization, double-click on it in the Dataset Objects pane:

If you’re using a grid visualization, the metric will be added to the right
side of the grid:
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Adding a New Metric (Derived Metrics)
In some cases, you may want a metric that isn’t there by default. In such
cases, it may be possible to create the metric you want, as long as there’s
another object you can build the metric off of. These types of metrics you
create on-the-fly are called derived metrics.
For example, let’s say we want the number of checkouts in our
visualization. The problem: there’s no such metric. The possible
solution: is there something else in the cube that we might be able to
“count” that would reveal the number of checkouts?
The attributes that are in the cube can sometimes open up possibilities for
a new metric. While there isn’t a metric called “number of checkouts”
there is an attribute called Checkout Id:

When you see an attribute termed as an “Id”, that means it is a unique
key assigned to each row. In other words, each checkout ever recorded in
the cube has a unique checkout Id assigned to it by the system. This
process happens across many different data points in your database.
Every user in your system has a unique User Id, every item has a unique
Item Id, and so on.
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The sample data below shows an example of checkout Ids:

The ID numbers are likely gibberish to you. That’s fine, as we’re not
planning on displaying them. However, they can be useful if we can
count them. If you could create a metric that performs a “count” on the
Checkout Id attribute, you are getting the number of checkouts.
Then, if you put that metric in a dashboard along with an atttribute like
the Checkout Library, the metric will display the counts in a way that
suits the attributes next to it. In other words, you are then getting
“number of checkouts by library”.
The example below shows how a “number of checkouts” metric can be
created and added.
To Add A Derived Metric to the Visualization
1. In the Dataset Objects pane, hover your mouse over the
Checkout Id attribute, and click the drop-down arrow:

2. From the menu, select New Metric -> Count:

BLUEcloud Analytics Administration

3. Notice that a new metric called Count (Checkout Id) has been
added to the Dataset Objects pane:

4. Double-click the Count (Checkout Id) metric. It will append to
the end of the visualization:
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Rearranging Attributes and Metrics
By default, attributes will display in the order in which you added them.
This applies to metrics as well (though metrics will always show after the
right-most attribute). Later, you may want to re-arrange attributes or
metrics in a different sequence.
In the example below, we’ll make the Checkout Year the left-most
attribute.
To Re-order an Attribute or Metric
1. Hover your mouse over the Checkout Year column header so you can
see the drop-down arrow.
2. From the drop-down menu, select Move Left:

The checkout year should now be the left-most attribute:

You might have noticed that the left-most attribute automatically is
sorted in ascending order. This holds true until you manually sort the
data in some other way.
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Deleting Attributes and/or Metrics
Attributes and/or metrics can be removed from the visualization. In this
example, we’ll take the Checkout Library attribute out.
To Remove an Attribute or Metric
1. Hover your mouse over the header of the attribute or metric in
question so that you can see the drop-down arrow.
2. Click the drop-down arrow and select Remove from the menu:

3. The attribute/metric should now be removed from the
visualization:
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Adding a Sort
By default, BLUEcloud Analytics will sort your visualization by the leftmost column of data. This holds true until you add a sort of your own.
The example below demonstrates a “simple” sort, done by the Checkout
Count in descending order.
To Perform A Simple Sort
1. Hover your mouse over the column header you’d like to sort by so
you can see the drop-down arrow.
2. Click the drop-down menu, and select either Sort Ascending or Sort
Descending:

3. Your data will now be sorted by that column:

A sort will become part of the definition of the visualization. In other
words, if you save the dashboard with a sort, that sort will be the default
the next time it is viewed.
Sorting by multiple columns is also possible, and will be covered in a
later chapter.
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Changing the Visualization
To this point, we’ve been using a grid visualization. Grids are often a
great way to begin, but you may later decide that you’d rather display the
data in a graph format (in the Dashboard Formatting chapter later in this
guide, we’ll discuss how you could have it both ways).
BLUEcloud analytics provides you with many different types of graphs
including bar and pie charts, heat maps, and scatter plots.
Be aware that you should choose a graph type that is appropriate for
what you are trying to highlight in the data. For example, if your intent is
to show how different categories contribute to a whole, a pie chart may
be the best choice. In another case where you want to highlight changes
over time, the very same data might be better displayed with a line chart.
Also, some graph types will only be made available when your data
meets certain conditions. For example, some of the “stacked area” graphs
will require multiple attributes and at least one metric, and will not be
selectable if your visualization doesn’t meet those requirements.
To Change a Visualization
1. In the toolbar, click on the Change Visualization button:
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2. From the Select a Visualization dialog, select the visualization
category. In this example, we’l select the Pie Chart category:

3. Some visualization categories will have subcategories from which
you can choose. Notice the pie chart category offers both Pie and
Ring variants. In this example, we’ll select the Pie subcategory:
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4. The visualization is now displayed as a pie chart:

Saving the Dashboard
“Saving” a dashboard means saving the definition so you can run it again
at a future time without having to recreate it. If a dashboard is intended
for use by many users, you may want to save it to the Shared Reports
folder (if your user permissions allow you to do so). The other option is
the other option is the My Reports folder, which is only visible to your
BLUEcloud analytics login.
If you save an object to the Shared Reports folder, it is visible to all users
by default. However, it is possible secure objects and folders in order to
limit who sees them. See the BLUEcloud Analytics Administration Guide
for more information on security.
To Save a Dashboard
1. In the toolbar, click the Save button:
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2. In the Save As dialog, select where you would like to save the
dashboard. In this example, we’ll place it in the My Reports
directory.
3. Also in the Save As dialog, provide a name for the dashboard in the
Name field:

4. The dialog below will confirm your save. You can then either Return
to original dashboard or Run newly saved dashboard. In this case,
we’ll click Run newly saved dashboard:

Now that your dashboard is saved, you can bring it back up later at any
time by double-clicking its icon in the location you saved it:
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To Delete a Dashboard
1. Click the red “X” in the upper right hand corner of the
visualization you wish to delete.

Note: There is no confirmation screen, once you click the “X” the
visualization will be deleted. However, you can “Undo” your
deletion by clicking the “Undo”
Toolbar.
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Analyzing Data:
Manipulating, Filtering,
and Drilling
Introduction
An advantage of analytics dashboards is how they present the data. The ability to have
combinations of grids and graphs of data can greatly assist you in understanding your
library data at-a-glance.
However, without learning some additional techniques, you may end up suffering from
seeing too much data. The visualizations we created in the previous chapter, while a
good start, may need to be more specific. Do you really want to see all checkouts from
every year available every time you run the dashboard?
This chapter focuses on techniques you can use to “kick around your data. These
techniques will include of inclusion/exclusion, filtering, and drilling.

Filtering
Many of your analytics projects will incorporate a filter, which is a condition that
restricts the data displayed. For example, our current visualization could be filtered to
show only certain checkout years, or only display rows with more than 500 checkouts.
At this point, our visualization is completely unfiltered. We are looking at the total
count of checkouts across all available checkout years. While this is still potentially
useful, visualizations are often more meaningful by reducing it to only the data you
want. Filters are the key to this.
In traditional reporting, unfiltered data is regarded as undesirable from both a
performance and comprehension standpoint. However, in analytics, it is the nature of
the process to start with the entire “cube” of data. You then reduce your data set down
to what you want through filtering.
Filtering can be done on both attributes and metrics. In dashboard visualizations, there
are different interfaces available for filtering, including:

BLUEcloud Analytics Administration

Checkbox:

Slider:

Search box:

Radio button:
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Drop-down:

Some filtering interfaces are more suitable than others depending on your
intent. For example, a slider would be handy when you want to select
from a range of values, while a radio button or drop-down interface is
useful when you want to permit only one selection.

Filtering on Attributes
In many cases, you’ll want to create one or more filters on attributes in
the dashboard, such as limiting by library or year.
In this example, we’ll add a slider-style filter to our visualization that
allows for selection of a range of values from the Checkout Year attribute.
To Add an Attribute Filter Condition to a Visualization
1. In the Grid pane, hover your mouse over the attribute or metric so
you see the drop-down arrow.
2. Click the drop-down arrow, and from the menu, select Add to
Filters:
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3. The filter interface will default to a checkbox style, as shown
below:

4. To change the style, hover your mouse over the Checkout Year
attribute in the Filters pane so you can see the drop-down arrow.
5. Click the drop-down arrow, and select Display Style -> Slider
from the menu:

6. The filter interface is now in slider form. Drag the end-arrows
with your mouse to narrow the range of checkout years. The
example below has been narrowed to 2009-2011:

7. By default, the filter is inclusive in nature, and is showing only
data from 2009-2011. If you wish to make it exclusive instead, use
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this menu combination:

8. The vizualization is now filtered to show all checkout years except
for 2009-2011:
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Filters on Metrics: Qualifications
When filtering on metrics, you are dealing with numbers on which you
may want to perform mathematical filters. Because of this, you’ll likely
want access to common mathematical operators like “greater than”, “less
than”, “equals”, and other variants. This type of filter where you set such
a condition is called a qualification metric filter.
The example below filters a large amount of checkouts by restricting to
rows with 100 or more checkouts.
To Apply a Qualification Filter on a Metric
1. In the Edit Visualization pane, hover your mouse over the metric so
you can access the drop-down arrow (note: if you don’t see the Edit
Visualization pane, you can enable it in the toolbar in Show -> Edit
Visualization ):

2. Click on the arrow, and select Add to Filters from the menu:
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3. In the Filters pane, hover your mouse over the metric (in this case
Count (Checkout Id) so you can access the drop-down arrow:

4. Click on the arrow and select Display Style -> Qualification:

5. You should now have an interface in the Filters pane similar to the
following:

6. From the drop-down, make sure Greater than or equal to is selected,
type 100 into the value box, and press <Enter>.
7. The grid should now be restricted to rows with 100 or more
checkouts:
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Clearing/Deleting Filters
“Clearing” a filter means clearing the data restriction, yet keeping the
filter interface visible so you can use it again. By contrast, “deleting” a
filter involves both clearing the restriction and getting rid of the filter
interface altogether.
Filters can be cleared individually, or all at once in the event you have
more than one. Filters can be deleted individually.
To Clear a Single Filter Condition
1. In the Filters pane, click the Clear Filter icon next to the attribute
or metric filter you want to clear:

To Clear all Filter Conditions
1. In the Filters pane, click the top-most Clear Filter icon:
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To Delete a Filter
1. In the Filters pane, hover your mouse over the attribute or metric
until you see the drop-down arrow.
2. Click the drop-down, and select Delete from the menu:
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Including/Excluding Data
The previous sections discussed filters, and how they can take a very large cube of data
and give you surgical control over what appears in your output.
This section discusses some menu items that let you quickly include/exclude data.
Basically, these are quick filter options that are given their own separate menu options.
If filters are surgical tools, these could metaphorically be considered blunt instruments.
Specifically, we’ll discuss Exclusions and Keep Only.
With both grid and graph visualizations, you can ‘zoom in’ on a subset of the data for
more details. In the examples below, we’ll start with dashboard that displays data from
the Checkouts cube, including Checkout Library, Checkout Year, Checkout Month,
and a Count of checkouts:

We’ll then apply some exclusion/inclusion techniques to narrow the data set.

Excluding Data
In this first example, we’re going to remove rows from the grid for a
library that is slated for removal from the system (“BEING REMOVED –
NOT HOLDABLE”).
To Exclude Rows By An Attribute Value
1. In the grid, hover your mouse over the attribute value you want to
exclude so you can access the drop-down arrow:
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2. Click on the arrow, and from the menu, select Exclude:

In the results, note that all rows for the BEING REMOVED – NOT
HOLDABLE library have been removed from the grid, even though we
applied this action to just the first instance of this library. When you
exclude by an attribute value in this manner, you are excluding ALL rows
with that value.
Could this be done with a proper filter? Sure. But exclusions give you a
quick, click-oriented way to get rid of something you don’t want.

Multiple Exclusions
You can add as many exclusions as you’d like to a data set, which will
further reduce the data being displayed.
The last example excluded a library that we didn’t want. Let’s perform
another exclusion, but this time in the Checkout Year on the 2011 value:
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we will have eliminated not only the BEING REMOVED – NOT
HOLDABLE library, but also Checkout Year 2011 rows for any library:

Exclusions on Metrics
Exclusions can also be applied to metrics. An important distinction from
attribute exclusions: when performed against a metric, the exclusion
removes only the selected row, even if there are other rows that share the
same metric value.
In the following example, we’ll target this row for removal:

To Exclude Rows By A Metric Value
1. Hover your mouse over the metric value so you can access the dropdown arrow:

2. Click on the arrow, and select Exclude from the menu:

The selected row has been removed from the results. However, note
that only that row was removed. Other rows that also have a
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Checkout count of 1 are still in the grid:

This is an expected behavior of exclusions when it comes to metrics.
To achieve a complete removal of rows based on a metric value, use a
filter.

Removing Exclusions
To remove exclusions, do one of the following:
1. Use the Undo button in the toolbar (assuming the exclusion was a
relatively recent operation):

2. Click on the Filters button above the data set. Here, you can clear
exclusions one at a time, or clear them all at once:
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Keep Only: By Attribute
This example will demonstrate the opposite principle of exclusion:
including only rows that meet a certain attribute value. Starting with the
same Library -> CKO Year -> CKO Month -> CKO Count data set, we’re
going to alter the grid to keep only rows that are from the Hancock
library.
To Keep Only Rows of a Specific Attribute Value
1. In the grid, hover your mouse over the attribute value for rows you
wish to keep, so you can access the drop-down arrow. In this
example, any Checkout Library of Hancock will work:

2. Click on the drop-down arrow, and select Keep Only:
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Keep Only: Not Cumulative In Nature
The Keep Only feature is a nice way to perform a “one-off” filtering
operation against the original data set. However, it is important to
understand that subsequent Keep Only operations will not further filter
the data, but rather replace what was done in the previous Keep Only
operation.
Let’s extend our last example where we did a Keep Only to reduce rows
to the Hancock library. What happens if we do another Keep Only on this
grid with the intent of further reducing the data to the Checkout Year
2013? Do we really end up with “Checkouts at Hancock in 2013”?

The result: we’ve replaced the previous Keep Only operation. So while the
data set has been reduced to 2013 checkouts, we’re no longer restricted to
the Hancock library:

The important lesson here: filters are the best way to specify a set of
conditions you’d like to apply. A couple of filters could easily achieve
something like “2013 Checkouts at the Hancock library”. Keep Only is
best used with intent of a one-off change to the original data.
You can use filters on top of a Keep Only operation and get cumulative
effects. Just understand that only one Keep Only is operating at once.
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Drilling
Drilling allows you to explore data beyond what is visible in the current output. It
gives you a way to “take a peek” at related data, such as additional attributes that might
be relevant to the current dataset, but aren’t a permanent part of the dashboard.
Example: you have a dashboard built from the Checkouts cube that displays general
information such as the library, the date, and the number of checkouts. While you like
the useful, at-a-glance data it provides, say you also want the ability to “zoom in” and
see who did the checkouts, or perhaps which items were checked out. This is the general
idea behind drilling.
This section will focus on a couple of techniques: one literally called “Drill”, and “Keep
Only and Show”.

Drill
In this section, we’ll focus on the Drill feature found in the context menus
in a dashboard. Drilling can be done on any attribute (like Checkout
Library) or attribute value (like the Kingston Library).
Will the drill feature, you can include more attributes into the dashboard.
But not only that, you’re incorporating that new data relative to where
you initiated the drill. So drilling from a specific library to add Item Ids
to a dashboard will add Item Ids transactions relevant to that library.
Also, the data you incorporate via drilling is subject to whatever filters
are in place.
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For illustrative purposes, we’ll explore drilling using very small data sets.
Bear in mind that drilling can apply to rather large data sets if you like.
But to facilitate demonstration, let’s start with the grid below that is
limited to Kingston library checkouts, and only in the years 2007 and
2012.

In this first example, we’ll drill from the Checkout Year attribute down to
the Item Id.
To Drill from an Attribute
1. Hover your mouse over the attribute so you can access the dropdown arrow:

2. Click the arrow, and select Drill -> Item Id from the menu:
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3. You should see results like the following:

Two important things happened here: 1) We’re now displaying the Item
Id instead of the Checkout Year, and 2) we went from 3 rows of data to 7.
Why the increase in rows? Notice that the original data set had 7
checkouts total (1 in Feb. 2007, 1 in Oct. 2012, and 5 in Nov. 2012).
Because we drilled from the Checkout Year attribute (rather than doing it
from a specific year), we drilled into Item Ids from all years listed (2007
and 2012). The filters in place also continued to constrain the results to
the Kingston library.
To cancel the drill, use the Undo button in the toolbar.
Now, let’s start with the same original data set, and drill from an attribute
value. Let’s see what happens when we drill from a specific year, like
2012.
To Drill from an Attribute Value
1. Hover your mouse over the attribute value so you can access the
drop-down arrow:

2. Click the arrow, and select Drill -> Item Id from the menu:
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3. You should see results similar to the following:

The attribute value we drilled from (within the Checkout Year) was
replaced by what we drilled to (Item Id). This time, we ended up with 6
rows. Why? Out of the 7 total checkouts from our original data set, 6 of
the 7 rows were from 2012. The checkout from 2007 was not included.
To cancel the drill, use the Undo button in the toolbar.

Keep Only and Show
The Keep Only and Show feature is a special drilling function with its
own distinct menu item. It gives you a quick way to drill for more
information within the context of a selected row, where the drilling
concept described in the previous section tends to affect many rows at
once.
As a case study for Keep Only and Show, consider this grid which has a
row of 6 checkouts in August 2013 for the Hancock library:

While this is good general information, what if I want to know which
items were checked out? Or what if I want to know who did the
checkouts? And in either case: just for that row.
In the example below, we’ll zoom in on this row of data to explore which
items were checked out.
To Use Keep Only and Show:
1. In the grid, hover your mouse over the metric you wish to explore so
you can access the drop-down arrow:
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2. Click the arrow, and select Keep Only and Show -> Item Id from the
menu:

3. A new grid appears, showing details about each of the six checkouts
including the Item Id:

You can use Keep Only and Show again to continue “zooming in”. For
example, you could find out who did the first of the six listed checkouts
by invoking this feature on the first row’s Count (Checkout Id) metric,
but this time showing the User Id:

This will result in one row that includes the User Id:
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Removing Keep Only and Show
To remove Keep Only and Show operations, do one of the following:
1. Use the Undo button in the toolbar (assuming the Keep Only and
Show was a relatively recent operation):

2. Click on the Filters button above the data set. Here, you can clear the
Keep Only and Show operation:
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Notes on Exploring Graph Visualizations
This chapter largely focused on grid visualizations, mainly because it is easier to
illustrate how the output is changing by demonstrating with a grid. However, graph
visualizations also allow for all of the features shown in this chapter.
The concepts we’ve discussed have the exact same impact in graph visualizations; what
changes is the method of accessing the features, in most cases.

Filtering
Creating and altering filters with a graph is no different than with a grid.
You can access the same Add to Filters option when working with a
graph:

Keep Only / Exclude/ Keep Only and Show
These options are available either by clicking on a specific object in the
graph (like a specific bar), or by highlighting an area via a mouse drag. In
the latter case, the operation is performed on the values selected.
In the example below, a bar is first selected with a mouse click, and then
the drop-down can be accessed by hovering on it:
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In the screenshot below, an area been selected by dragging a box around
a set of bars. The selected operation will then be applied to all data
within the bounded area:

You can also find Keep Only and Exclude wherever attribute values are
displayed, such as the checkout library:
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Drill
Drilling can also be done against a graph. The trick is to look for the
attributes and attribute values (the exact location of them can vary
depending on the type of graph you’ve selected).
Like drilling in a grid, you can drill against a specific value (the “Coloma”
library in the screenshot), or do a more general drill against the attribute
itself (the “Checkout Library”):
In the screenshot below, we could start a drill s from the checkout library
of Coloma:

If we wanted to drill starting from all checkout libraries currently in the
dashboard, we could initiate the drill from the attribute itself:
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Dashboard Formatting
Introduction
The dashboards shown in previous chapters were all simple one-grid/one-graph reports.
Feel free to create simple dashboards. Many consumers of your reports won’t require
anything more complicated.
However, some consumers may want a wide range of information available within one
dashboard. They may want several grids and graphs on one page, or perhaps spread
across several adjacent pages accessed by tabs. An example of this type of dashboard is
shown below:

This chapter will discuss usage of visualizations, layouts, and panels, each of which can
play a role in designing more versatile dashboards.
The “anatomy” of a dashboard that includes all three of these elements is shown below:

BLUEcloud Analytics Administration
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Multiple Visualizations
In this example, we’re going to create a dashboard that initially has 1 layout, and three
visualizations:

Setup: the Visualizations
Because we’ve already spent previous chapters covering the mechanics of
creating visualizations, we’ll quickly summarize the content of each one
here. The step-by-step instructions that follow will focus on the
arrangement of them into one dashboard.
Visualization 1: Number of checkouts by month in 2014, restricted to the
Berlin library. Type: vertical bar chart.
Visualization 2: Checkouts by day-of-week in 2014, restricted to the
Berlin library. Type: pie chart.
Visualization 3: Item status counts, restricted to the Berlin library. Type:
horizontal bar chart.
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Setup: Filtering
When planning a dashboard, a critical thing to understand is this: filtering
will apply to all visualizations within a given layout, including multiple panels
within the layout.
Looking at our planned visualizations, notice that all three of them will
filter to the Berlin library. Because filters are global in nature within a
layout, this will be easy to do. As soon as one of the visualizations is
filtered to the Berlin library, other visualizations in the layout with the
library attribute will automatically be subject to the same filter.
Two of the visualizations also have a constraint to the year 2014. As long
as that filter exists somewhere in the layout, anything in that layout with
the Checkout Year attribute will be subject to that filter
If that sounds like a problem: this is where multiple layouts can be useful.
For example, we could have separate layouts for different libraries, thus
having a shared dashboard with a tab for each:

In the above example, any visualizations in the Brandon layout would
not be affected by filters in either of the other two. Each layout could be
filtered by their own library, leading to a shared dashboard.
If the idea of a shared dashboard between libraries makes you cringe, you
can simply design separate dashboards for each, put them in separate
folders, and secure them accordingly (see the BLUEcloud Analytics
Administration class for more on this). As stated early in this chapter, not
everyone is going to go full-steam-ahead on complex dashboards.

Creating the Dashboard
In this example, we’ll now create the 1-layout/3-visualizations dashboard.
On your system, you can vary the library/year options to ones suitable to
your library’s data.
To make the example slightly easier to follow, we’ll first create each
visualization as a grid so that you have a clearer picture of the setup.
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We’ll then convert them to graphs. Experienced users can by-pass that
step and create them as graphs to begin with.
When you have multiple visualizations in a layout, make sure you have
first selected the one you want to work with using a mouse click. The
highlighted visualization is the one that your attributes/metrics will be
added to.
To Create a Dashboard with Multiple Visualizations
1. Create a new Dashboard using the Checkouts cube as your data
source.
2. In the visualization, create the first example: Number of checkouts by
month in 2014, restricted to the Berlin library. Type: vertical bar
chart. Prior to converting it to a bar chart, it should look similar to the
following in grid form:

3. If your visualization was created as a grid, convert the visualization to
a bar chart using the Change Visualization option either in the main
toolbar, in in the visualizations drop-down menu.
4. In the main toolbar, select Add Visualization -> Grid:

BLUEcloud Analytics Administration

5. This should give you an empty visualization box on the right:

6. In the new visualzation, create the second example: Checkouts by
day-of-week in 2014, restricted to the Berlin library. Type: pie chart.
Prior to conversion to a pie-chart, the data should look similar to the
following:

Note that you do not have to do any additional filtering, because you
already created the “Berlin” and “2014” filters for the first
visualization.
7. If your visualization was created as a grid, convert the visualization to
a bar chart using the Change Visualization option either in the main
toolbar, in in the visualizations drop-down menu.
8. In the main toolbar, select Add Visualization -> Grid:
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9. This should give you a new empty visualization off to the right:

10. In the new visualization, create the third example: Item status counts,
restricted to the Berlin library. Type: horizontal bar chart. In grid
form, your data should look similar to the following:

If your visualization was created as a grid, convert the visualization to
a vertical bar chart using the Change Visualization option either in
the main toolbar, in in the visualizations drop-down menu.
11. At this point, your dashboard should look like this:
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Rearranging the Visualizations
You may have noticed that visualizations default to a side-by-side
arrangement. You can alter this arrangement by dragging and dropping
the visualizations.
Let’s drag-and-drop the right-most visualization below the other two.
While dragging, you should see a blue line that shows where the drop
will occur:
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The third visualization should now have its own space on the bottom half of the layout:

By default, the system will give each visualization an even amount of
space (50-50 on the top half, in the above example). Be aware that you
can resize each visualization by dragging it by its borders.
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Panels
You can have as many visualizations as you want on a layout. However, the more
visualizations you have, the less space each one will have to occupy. So while you could
have ten visualizations on one layout, they would be rather small.
This is where additional panels could come in handy. To this point, we’ve actually been
putting our visualizations in the default panel of the layout. If you want a dashboard to
have tons of visualizations that are subject to the same filtering conditions, you can
subdivide a layout into separate panels. This gives you more space to work with.
To Add Additional Panels to a Layout
1. In the Tools menu in the main toolbar, select Add Panel:

2. Your layout should now have a new panel in which you can place
more visualizations:

From this point, you can add visualizations to the new panel using the
exact same methods you used in the default panel.
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Additional Layouts
While panels are used to give you more space within a layout, sometimes you may
additional layouts. The chief reason to have multiple layouts is to allow for multi-page
dashboards where different filter conditions could apply to each page.
For example: our previous dashboard project had one layout filtered to the Berlin
library. What if, in the same dashboard, I want content that is filtered to the Brandon
library? I would need a new layout for that, since the existing layout is already filtered
to Berlin.
Another possible reason you might use additional layouts: you like the “tabbed” look
better than the dots-in-a-tab look that panels provide, regardless of filter considerations.
The example below shows creating a new layout. In this case, it is intended to provide a
tab in the dashboard where visualizations for the Brandon library can later be placed.
To Add a New Layout:
1. Click on the Add Layout tab next to the existing layout tab:

2. By default, the layout will have a patterned name like layout 1. You
can rename it by hovering on the new layout tab so you can access the
drop-down arrow:

3. Then, click on the arrow, and select Rename from the menu:

BLUEcloud Analytics Administration

4. Type in the name of the new layout:

You now have a new layout with a default panel. You can add
visualizations to it using the same methods as before. But let’s introduce
another method at this point: copying.
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Copying / Moving Data
In a multi-page dashboard scenario, you may sometimes want similar reports across
different panels or layouts. For example, maybe our new layout for the Brandon library
wants to have content similar to Berlin’s, but filtered to themselves.
While you could recreate the same visualizations from scratch, it may be easier to copy
or move any similar visualizations, and then adjust them.
“Copying” and “moving” mean exactly what they do in other software contexts.
Copying creates a second, independent copy, while moving transfers the visualization
from one place to the other.
Copying and moving can be done between both layouts and specific panels. The
example below copies one of the Berlin layout’s visualizations over to Brandon’s.
To Copy / Move a Visualization:
1. Hover your mouse over the title bar of the visualization so you can
access the drop-down arrow:
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2. Click on the arrow, and select Copy to or Move to from the menu:

3. Your options at this point depend on what panels and layouts are
available (also notice you could create new panels and layouts on-thefly this way). In this case, we’ll copy to the Brandon layout:

4. The Brandon layout now has the same visualization.
Be careful here. Just because our visualzation has been dropped into a
tab of a particular name doesn’t mean the data has technically been
altered appropriately. This visualization doesn’t truly become the
Brandon library’s until we adjust the filters within this layout to make it
so:
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Also, the Berlin layout was restricted to the Checkout Year of 2014. If that
is needed in the Brandon layout, that filter would have to be recreated as
well.
Now that that Brandon layout has a filter for the Brandon library, any
additional visualizations that are copied or moved to it will restrict by
that filter (as long as the visualization contains the Checkout Library, in
this case).
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Text Fields and Renaming Visualizations
Some finishing touches to this dashboard would be nice. Let’s look at Text Fields,
Renaming of visualizations, and Properties.

Text Fields
Text fields give you one or more places where you can enter free text
amongst the visualizations. In this example, we’ll add a caption to the
top of the Berlin library layout that reads Berlin Library Activity in 2014.
To Add A Text Field:
1. In the Tools menu in the main toolbar, select Add Text Field:

2. The text field should default to the top of the layout. Within the field,
type the desired text, such as “Berlin Library Activity in 2014”:

3. If you want to perform additional formatting such as alignment and
font options, hover your mouse on the text box and click on the
icon to the right:
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4. In the menu that appears above, you can then adjust alignments and
fonts.
If needed, you can have multiple text fields. They can also be dragged to
different sections of the screen just like visualizations, as well as resized.

Renaming Visualizations
The default names of visualizations tend to be rather non-descript:

The exercise below renames the left visualization to Checkouts by
month.
To Rename a Visualization:
1. Hover your mouse over the visualization’s title bar so you can access
the drop-down arrow:
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2. Click on the arrow, and select Rename from the menu:

3. Enter the desired text, such as “Checkouts by month”:
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Formatting
Introduction
This chapter will focus on a variety of topics, but all of them point to the same general
end-game: providing options that may improve the readability and appearance of your
dashboards.
Also note that these concepts can apply to other types of reporting output besides
dashboards. You will have access to most of these options when using documents and
reports as well.

Advanced Sorting
You can perform two types of sorts: a “simple” sort against a column of your choosing
(discussed in chapter 2 of this guide), or an “advanced” sort which allows for sorting
against multiple columns.
You can sort by as many attributes or metrics as you like. Initially, the sorting dialog
will provide for three sorts, but it will give you more “slots” to provide additional sorts
if you use up the existing ones. You can choose an ascending or descending option for
each sort.
The example below adds three sorts to a dashboard: by Checkout Library, Checkout
Year, and Checkout Month.
To Perform an Advanced Sort:
1. In the Grid pane, hover your mouse over any attribute or metric so
you can access the drop-down arrow:
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2. Click on the arrow, and from the menu select Advanced Sort:

3. In the Sort dialog, select up to three sorts, similar to the example
below:

4. Click OK to finish the sort. The results should look similar to the
following:
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There’s one thing that doesn’t look right here: even though we
“sorted by month”, the method we selected did the sort on month
alphabetically, rather than chronologically:

When performing your sort, pay careful attention to a couple of
things:
1. Date attributes like month or day-of-week may provide you a
“numeric” option (for example, months are considered as “112” rather than alphabetically by name). The numeric option
leads to a more logical sort in these cases:
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2. Some attributes, especially Symphony policies or Horizon
codes, may present sort options by the code (the ID) or the full
description (noted as DESC in the example below):

In these cases, it generally makes more sense to the user to sort by
whatever you are displaying in the visualization. If you’re showing the
full library description, it’s usually better to sort that way.
NOTE: These ‘variations’ of attributes, such as the ID and DESC forms of the
Checkout Library, are called attribute forms. SirsiDynix determines the
various attribute forms that are available for use.
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Page-by
The Page-by feature provides a convenient way to view a large data set in slices. It is
designed to be used with grid visualizations.
For example, take the following output from a checkouts dashboard that goes on for
potentially thousands of rows, especially when little filtering is applied:

One obvious solution to a large data set is to apply filters. Another option that help is
Page-by, which lets you “split” the data by an attribute into different pages, rather than
one enormous page of data.
The example below moves Checkout Library into the Page-by axis, and allows you to
choose the library via a drop-down.
To Use the Page-By Feature:
1. In the Grid pane, hover your mouse over the Checkout Library
attribute so you can access the drop-down arrow:
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2. Click on the arrow, and select Add to Page-by:

3. The data should now be separated into “pages”, where each library
can be selected with buttons:

4. If desired, you can change the Page-by interface to either a slider or
drop-down interface by hovering over the attribute in the Page-by
attributes so you can access the drop-down arrow:
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5. Click on the arrow, and select Drop-down from the menu:

You can now select the library in drop-down form:
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Move to Columns (cross-tabbing)
All of grid visualizations so far have been of the “vertical” type, where all data displays
on the y-axis. Sometimes you may want to display one or more attributes across the xaxis to enhance readability. For example, how could we display a grid where the
Checkout Month displays like this?

The example below shows the Move to Columns feature.
To Use Move to Columns:
1. In a grid visualization, hover you mouse over an attribute like the
Checkout Month so you can access the drop-down arrow:
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2. Click on the arrow, and select Move to Columns from the menu:

3. The grid should now show the chosen attribute along the x-axis.
This does leave one formatting issue: let’s say you want to fix the
repetitive Count (Checkout Id) notations as shown below:

In the Checkout Month drop-down, we can use the Move Down option,
resulting in this:
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Thresholds
Thresholds are a way to conditionally apply background colors to metrics in grid
visualizations. With thresholds, you can draw the user’s attention to key pieces of data
that meet a certain condition, such as “number of checkouts > 1000”. A thresholds
consists of a condition to be met, and a color to apply.
The example below will demonstrate creating three thresholds. To simplify things, we’ll
work against this small grid:

Our three thresholds will be:
1. Number of checkouts < 100: Green
2. Number of checkouts between 100 and 1000: Blue
3. Number of checkouts > 1000: Red
The system will default to giving you five threshold “ranges”, which you can add to or
subtract from. Since our example requires only three ranges, part of the process will be
taking two of them out.
To Add A Threshold to Grid Visualization:
1. In the Grid pane, access the drop-down arrow next to the Checkout
Id metric, and select Thresholds… from the menu:
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2. By default, the system should give you this dialog which defaults to
five threshold ranges (two of which we’re going to delete):

3. To delete a threshold range, hover your mouse within the box, and
click on the “x” to delete it:
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4. Repeat step 3 and delete one more threshold range (it doesn’t matter
which one. For this example, just make sure you end of with three
ranges). At this point, your threshold dialog should look something
like this:

5. Next, we’ll make a change so that the thresholds are based on exact
numbers we specify, rather than the Lowest % basis that it is
defaulted to. Click on the Based on: Lowest % in the drop-down, and
select Value:

6. Next, we’ll set the left threshold range to look for values “less than
100”. The easiest way to set an exact value is to click on the slider, at
which point you’ll get a pop-up to fill in 100:
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7. Our next theshold range (the middle) will end at 1000. Set it in a
manner similar to step 6, as per the screenshot below:

8. The third (right) threshold doesn’t require any addtional work as far
as the condition goes. It simply encompasses the remaining values
not covered by the other two thresholds.
9. To set the color for the first (left) theshold, hover your mouse within
its range box, so you can see the color button:

10. From the color dialog, pick a background color for the first threshold
(since the text will be in black, make sure to pick a lighter shade):
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11. Repeat step 10 for both the second and third threshold ranges. You
should end up with something similar to the following:

If you no longer want to use thresholds, you can clear them by
accessing the drop-down for the metric in the Grid pane, and
selecting Clear Thresholds:
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Color By
Color By is the same concept as thresholds, except that they are intended for graph
visualizations. The methods used to create Color By effects are also very similar to those
used in thresholds, as the two main components are a condition, and a color to use when
that condition is met.
In the example below, we’ll do a Color By on the following graph of checkouts by
library/year:

There will be two conditions: blue bars for checkouts < 30, red bars if > 30.
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To Use Color By in a Graph Visualization:
1. In the Graph pane, click on the Add button in Color By:

2. From the dialog, select the metric off of which you’ll be basing the
Color By. In this case, we’ll mark the Count (Checkout Id) metric and
click OK:
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3. In the Graph pane in Color By, click on the Thresholds icon:

4. By default, the system provides you five threshold “ranges”. We only
need two for this example, so we’ll delete three of them. To delete a
range box, hover your mouse within it and click the ‘x”:

5. Repeat step 4 until you are left with two ranges as follows:

6. Next, we’ll make a change to the Based on setting so that we can set
exact numbers that define the Color By scheme. Click on the Based
on: drop down, and select Value from the menu:
BLUEcloud Analytics Administration

7. Next, we’ll set the value of the left threshold range (checkouts < 30).
To do this, either drag the slider, or click on it and enter 30 in the text
box:

8. The second (right) threshold range requires to further settings as far
as conditions, as it will account for all values not covered by the first
threshold.
9. Next, we can select colors for each threshold range. The left threshold
already has a blue color that we wanted. To change the second
threshold to a red color, hover your mouse over it and click the Edit
Color button:
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10. From the color dialog, select a color, and click the OK button:

11. Your Color By settings will be applied to the graph:
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Totals/Subtotals
If your report includes one or more metrics, you have the option to perform many
different types of calculations on them. These include standard “aggregate” functions
like counting, sums, and averages, or statistical functions such as standard deviation and
variance.
This section will cover the application of these functions using two of the most common:
grand totals and subtotals.

Grand Totals
A grand total can be placed in a visualization by invoking the totaling
function on the left-most attribute. The example below will apply a
grand total of the Count (Checkout Id) metric by applying a totaling
function to the Checkout Library attribute. Our test visualization will
consist of the data below:

To Add A Grand Total:
1. Access the drop-down arrow on the header of the left-most attribute,
select Show Totals from the menu:
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2. You should see a list of functions you can apply (you can select more
than one, if needed). Check the box next to Total and click OK:

3. You should see results similar to the following:

Subtotals
Subtotals are totals broken out by a certain category. Using our simple
visualization from a previous example, this shows subtotals by Checkout
Library:

Subtotals “by attribute” are generated by invoking the totaling function
on the attribute to the right. In other words the subtotals “by library” in
BLUEcloud Analytics Administration

the above grid were created by invoking the totaling function on the
Checkout Year, which happened to be the next attribute.
The steps below illustrate this in detail.
To Add a Subtotal:
1. On the attribute to right of the category you’d like a subtotal
breakdown, click on the drop-down arrow for the header of the
attribute and select Show Totals. Since we want subtotals by
Checkout Library, we’ll perform this act on the next attribute, which
is Checkout Year:

2. You should see a list of functions you can apply (you can select more
than one, if needed). Check the box next to Total and click OK:

You should have results like the following:
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Administration
User Creation
At this time, all user creation is handled by Client Care. Users should submit a ticket via
the Support Portal including a list of the users to be created and the passwords for each
account. Indicate on this list to which folders—Shared, My Folder, or otherwise—each
user should have access.

BLUEcloud Analytics Administration

User Preferences
Options for working with BLUEcloud Analytics objects can be customized for individual
users. Once Client Care has created users for a particular instance, that user or an
administrative user can log in and change their user preferences. Examples of what can
be defaulted in the Preferences menu include language, default home page, print and
export settings, and much more.
To set user preferences in BLUEcloud Analytics
1. Log in to BLUEcloud Analytics using the user name and password for
the account that needs adjustment.
2. From the upper left of any page, click the BCA Start icon.

3. Select Preferences.
The General preferences page is displayed.
4. In the left navigation, select a Preferences page containing the options
that are to be modified.
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Importing Data Files
Information from data files such as an Excel spreadsheet or a text file can be loaded into
BLUEcloud Analytics with very few layout or design requirements. The following file
types can be used to import data:
 .xls
 .xlsx
 .tst
 .cvs
The data can be imported directly into a dashboard or a document, or users can import
the data into a folder and create a dashboard or document from the imported data. Data
imported into BLUEcloud Analytics is saved as a cube. This allows users to use this data
immediately or save it for use with other dashboards and documents in the future.
To import data from a file into BLUEcloud Analytics:
1. On the home page, click the Import Data icon.
Or, from within a folder, click Create on the icon bar on the left.
Then click Import Data.

2. From the Select your Data Source panel to the left, click the File
icon.

3. Click Browse.
The Select a File to Upload window displays.
4. Select a file to import, then click Open.
5. In the lower right corner of the screen, click Continue.
A preview of the imported data is displayed on the Preview page.

BLUEcloud Analytics Administration

6. If the file is an Excel workbook with more than one sheet of data,
from the Sheet Name drop-down list, select the sheet from which
data should be imported.
By default, BLUEcloud Analytics assumes that data is stored in a
simple tabular, layout. Users can also choose to import data stored
in a cross-tabbed layout.
7. Select Tabular or Cross-tabbed and complete the following steps
as needed.
If Cross-tabbed is selected, the legend in the top right shows how
each type of data is displayed. As needed, complete the following
steps for cross-tabbed formats.
a. Highlight each cell containing metric data by clicking and
dragging the edges of the Metric data area.
b. Check the “No Metric Headers” check box if no metric
headers are contained in the file.
c. If metric headers are included in the file, uncheck the “No
Metric Headers” check box.
d. Click and drag the Metric header block area to highlight the
cells containing header information.
If Tabular is selected, adjustments cannot be made to the data
areas as described above, however, a user can add or modify
column headers if necessary as follows. These headers are used as
the names of the attributes and metrics being defined, so it is
important that they are accurate. Complete the following steps to
create new headers when none are displayed:
a. Check the “Insert new column headers” check box. A new
column header is inserted for each column.
b. Hover the cursor over a column header and click the arrow
icon in the top right area of the cell.
c. Select Rename. Enter a new name for the header.
d. Press Enter on the keyboard.
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8. Once all the necessary changes have been made, in the lower right
corner of the screen, click Continue.
The “Save Dataset” window is displayed. Depending on the
permissions of the user creating this new dataset, they may have a
choice in where to save the dataset.

9. In the drop-down menu, select the appropriate save location.
10. Enter a file Name and a Description if desired.
11. Click OK.
A confirmation screen displays. From this screen, users can select a type
of object they wish to create with this data cube—report, document or
dashboard—and begin analyzing the data immediately.

BLUEcloud Analytics Administration

Sharing Objects
Users with “full control” of an object and those with administrative privileges can
decide if other users or groups of users have access to that particular object. This is
handled by editing an object’s access control list in the “Share” submenu. As an
example, permission might be set to allow a user to view and run a report while keeping
the user from saving over or deleting a report. In addition to setting sharing
permissions, users can also use the Share submenu to share a link to the object via email.
Note: When modifying the permissions for a folder, changes will be applied to the folder and all
objects created in the folder in the future. If it is necessary to apply these permission to items
already in the folder, select the “Overwrite all child object” permissions check box.
The table below describes the permissions which can be assigned to a user or group of
users. These permissions do not apply to cubes.
Permission Level
View
Modify
Full Control

Denied All
Custom

Description
A user may browse, read and execute the object.
A user may both view and modify the object including write and delete permissions.
Grants all permissions for the object, including the ability to view, modify and delete the object.
Users can also grant permissions for the object to other users.
No permissions for the object are granted.
The user assigning permissions may create a custom combination of permissions. A pop-up
menu displays after selecting Custom which allows a user to select the permissions.

The following table lists the permissions which can be assigned to cubes.
Permission Level
Consume
Add
Collaborate
Denied All
Custom
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Description
A user may create or run reports with the cube.
In addition to creating and running reports, a user can republish or refresh the cube.
User has all permissions and can also modify the cube.
No permissions for the object are granted.
The user assigning permissions may create a custom combination of permissions. A pop-up
menu displays after selecting Custom which allows a user to select the permissions.
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To assign object permissions to a user or user group
1. From within a folder, right-click on the object and select Share.

Or, from within an open report, document or dashboard click the
Share icon on the Home toolbar.

The “Share” dialog box is displayed. The “Who has access”
section lists the users and groups who have or can have access to
this object.

BLUEcloud Analytics

2. To grant all users access to the object, select the All Users check
box. Or, use the Type users or groups here textbox to enter the
name of each user or user group the object should be shared to.

3. With either option, a drop-down menu is displayed. The user or
user group is assigned View permissions by default. Use the View
drop-down menu to change permissions.

Users can choose from the delivered permissions levels (described
in detail in the above tables) or choose their own combination of
permission to assign.
4. To assign custom permission, select Custom.

5. In the Custom Permissions Level window, select permissions to
assign to this object.
6. Click OK.
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Subscribing to Objects
BLUEcloud Analytics administrators and users can create email, file and print
subscriptions in a variety of ways. These subscriptions can be set up for reports,
documents and, when using email subscriptions, for dashboards as well.

Email Subscriptions for Reports and Documents
To create and email subscription in an open report or document:
1. From the Home menu, point to Subscribe to and select E-mail

BLUEcloud Analytics

2. In the Subscribe to Email Window, enter a Name for this email.
3. Select a Schedule for sending this email.
Note: BLUEcloud Analytics is delivered with schedules, if additional
schedules with different frequencies are required, please contact Client
Care.
4. Select an appropriate email address or use the To drop-down
menu to do the same.
Note: If this is the first subscription being created, or if there are no
addresses in a user’s preferences, the To: drop-down menu will not be
displayed. Use the To: button to add recipients.
5. In the Send drop-down list, choose how to include the report in
the email. Options include:
a. Data in email - Delivers data in an email message
b. Data in email and to history list - Delivers data in an email
message and also creates a message in the History List
c. Data and link to history list in email - Delivers both data and
a link to the History List in an email message, and creates a
message in the History List
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d. Link to history list in email - Creates a message in the
History List and delivers a link to History List in an email
message
6. Enter a Subject.
7. If it is necessary to preview the report or document, select the
Send a preview now check box.
8. If desired, expand the Advanced Options section. With the correct
permissions a user can:
a. Select the Password protect zip file check box
b. Enter a name for the zip file
c. Select an expiration date for the subscription.
9. Click OK.
A message displays confirming the subscription was created
successfully.

BLUEcloud Analytics

Email Subscriptions to Dashboards
To create and email subscription in an open dashboard:
1. From the Dashboard toolbar, select the Subscribe History List
icon.

The Subscribe to History List window is displayed.

2. In the Name text box, enter a subscription name.
3. In the Schedule drop-down list, select a delivery schedule.
Note: BLUEcloud Analytics is delivered with schedules. If additional
schedules with different frequencies are required, please contact Client Care.
4. Use the To button to select an appropriate email address.
Note: If this is the first subscription being created, or if there are no addresses
in a user’s preferences, the To: drop-down menu will not be displayed. Use
the To: button to add recipients.
5. If it is necessary to see this report immediately, select the Run
subscription immediately check box.
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6. If desired, expand the Advanced Options section. With the correct
permissions a user can:
a. Choose to have the new report overwrite an older version.
b. Schedule n report end date using the Do not deliver after
option.
7. To receive a delivery notification, select the Send notification to
email address: check box.

BLUEcloud Analytics

File Subscriptions
Creating a subscription to a file is similar to creating a subscription to email. When
creating a subscription to file, however, users will specify to which folder the object will
be saved. This will typically be a shared folder within BLUEcloud Analytics.
Note: With the appropriate privileges, users can create his or her own file location. File
locations must be accessible by the BLUEcloud Analytics server for the subscription to
execute successfully. Permission to save to the Shared Folder is set in the user login. If a
user needs access to save to the Shared Folder, this can be set up by contacting Client
Care.
With the proper permissions, users can compress a saved and password protect it. All
users can set an end delivery date using the Do not deliver after option.
The following image shows a sample file subscription defined in the Subscribe to File
window.
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Print Subscriptions
When creating a print subscription, scheduling options include subscription name,
schedule, expiration date, and instant preview. Users can also define a printer location,
range of pages to be printed, number of copies and whether to collate to printed
document.
Note: If users with the appropriate privileges, users can create his or her own print
location. If a user needs to set up a print location please contact Client Care for
assistance.
The following image shows the “Subscribe to Printer” window.

BLUEcloud Analytics
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